
Getting Started Guide

Agilent Technologies
N9020A MXA Signal Analyzer
Manufacturing Part Number: N9020-90001

Printed in USA
October 2006

© Copyright 2006 Agilent Technologies, Inc.



Notice
The information contained in this document is subject to change 
without notice. 

Agilent Technologies makes no warranty of any kind with regard to this 
material, including but not limited to, the implied warranties of 
merchantability and fitness for a particular purpose. Agilent 
Technologies shall not be liable for errors contained herein or for 
incidental or consequential damages in connection with the furnishing, 
performance, or use of this material.

The following safety symbols are used throughout this manual. 
Familiarize yourself with the symbols and their meaning before 
operating this analyzer.

WARNING Warning denotes a hazard. It calls attention to a procedure 
which, if not correctly performed or adhered to, could result in 
injury or loss of life. Do not proceed beyond a warning note 
until the indicated conditions are fully understood and met.

CAUTION Caution denotes a hazard. It calls attention to a procedure that, if not 
correctly performed or adhered to, could result in damage to or 
destruction of the product. Do not proceed beyond a caution note until 
the indicated conditions are fully understood and met.

NOTE Note calls out special information for the user’s attention. It provides 
operational information or additional instructions of which the user 
should be aware.

Additional Information
For the latest information about this analyzer, including firmware 
upgrades, application information, and product information, see the 
following URL: 

http://www.agilent.com/find/mxa
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1 Installation and Setup
• “Initial Inspection” on page 7

• “Turning on the Analyzer the First Time” on page 8

• “Navigating Windows Without a Mouse” on page 11

• “Power Requirements” on page 14

• “Instrument Location and Rack Mounting Requirements” on page 17

• “Instrument Maintenance” on page 18

• “Protecting Against Electrostatic Discharge” on page 19

• “Trademark Acknowledgements” on page 20

Technical Documentation:

The product documentation can be found a number of ways. It is:

1. On the documentation CD that shipped with your product

2. On the product website http://www.agilent.com/find/mxa_manuals

3. Accessed through the product Help system by selecting Other Documentation

4. Inside the N9020A MXA Signal Analyzer help directory 
C:\Program Files\Agilent\SignalAnalysis\Infrastructure\Help

The N9020A MXA Signal Analysis measurement platform: 

Getting Started Turn on process, Windows XP use/configuration, Front and rear panel 

Specifications Specifications for all available Measurement Applications and optional 
hardware (for example, Spectrum Analyzer and W-CDMA)

Functional Testing Quick checks to verify overall instrument operation.

Instrument Messages Descriptions of displayed messages of Information, Warnings and Errors

Measurement Application specific documentation: 
(for example, Spectrum Analyzer Measurement Application or W-CDMA Measurement 
Application)

Measurement Guide 
and Programming 
Examples

Examples of measurements made using the front panel keys or over a 
remote interface. The programming examples use a few different 
programming languages, and copies of the executable files are available.

User’s/Programmer’s 
Reference

Descriptions of front panel key functionality and the corresponding SCPI 
commands. May also include some concept information.
Chapter 1 5
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Installation and Setup
Figure 1-1. Agilent Technologies N9020A Signal Analyzer Measurement Platform

The MXA Signal Analyzer hardware can be used with a variety of Measurement Applications which 
must be purchased separately. It uses Microsoft Windows XP and is an open system.

NOTE Operating system settings have been optimized for the best performance. Modification 
of these settings may degrade instrument performance and measurement speed. 
Those that can be safely modified are described in “Instrument Configuration” on 
page 31.

The N9020A is an Open Windows environment, so you can install non-approved 
software on the instrument. However, installation of non-approved software may affect 
instrument performance. Agilent does not warrant the performance with 
non-approved software installed.
Chapter 16
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Initial Inspection
Initial Inspection
Inspect the shipping container and the cushioning material for signs of stress. Retain the shipping 
materials for future use, as you may wish to ship the analyzer to another location or to Agilent 
Technologies for service. Verify that the contents of the shipping container are complete. 

Shipping Problems?

If the shipping materials are damaged or the contents of the container are incomplete:

• Contact the nearest Agilent Technologies office to arrange for repair or replacement (“Returning 
an Analyzer for Service” on page 91). You will not need to wait for a claim settlement.

• Keep the shipping materials for the carrier’s inspection.

• If you must return an analyzer to Agilent Technologies, use the original (or comparable) shipping 
materials (see “Returning an Analyzer for Service” on page 91).

Item Description

Getting Started Guide Provides first-time power on instructions, licensing information, 
operating system information, and general hardware information.

Power Cable (See “AC Power Cords” 
on page 16)

Connection for instrument power.

Documentation disk PDF files for all manuals (except service), programming example 
files, and some technical Application Notes.

Agilent IO Libraries disk Software for establishing and configuring PC to instrument 
interfaces.

NOTE: If you purchased the Spectrum Analysis Measurement System software, or any measurement 
application software, the related manuals and accessories are also included.
Chapter 1 7



Installation and Setup
Turning on the Analyzer the First Time
Turning on the Analyzer the First Time
Initial power-on requires:

• “Powering On the Instrument”
• “Accepting the End-User License Agreement (EULA) Screen”
• “Setting System Date and Time”
• “Anti-virus Software and Firewalls”
• “Shortening the Instrument Power-on Time”

TIP You can get automatic electronic notification of new firmware releases and other 
product updates/information by subscribing to the Agilent Technologies Test & 
Measurement E-Mail Notification Service for Agilent instruments at 
http://www.agilent.com/find/notifyme

If you do not have a USB mouse available you may want to refer to “Navigating 
Windows Without a Mouse” on page 11.

Powering On the Instrument

1. Position the instrument so that you have easy access to the power cord and plug it in.

WARNING If this product is not used as specified, the protection provided by the 
equipment could be impaired. This product must be used in a normal 
condition (in which all means for protection are intact) only.

2. Press the power switch (located in the lower left-hand corner of the analyzer’s front panel) to 
turn the analyzer on. See “Front Panel Features” on page 22. 

The instrument can require >5 minutes to power-on. This time is affected by the Windows XP 
boot-up time and by the number of measurement applications that you are pre-loading. See also 
“Shortening the Instrument Power-on Time” on page 10.

NOTE Allow the spectrum analyzer to warm-up for 30 minutes before making a calibrated 
measurement. To meet its specifications, the analyzer must meet the operating 
temperature requirements.

Accepting the End-User License Agreement (EULA) Screen

The License Agreement screen asks you to accept the terms of the End-User License Agreement for 
Windows XP. You must accept this agreement to continue the Windows XP installation and 
configuration. If you do not accept this agreement, the instrument shuts down and the next time 
you turn it on the Windows XP Setup Wizard starts from the beginning again.

For more information about the End-User License Agreement for Windows XP, see the Questions 
Chapter 18



Installation and Setup
Turning on the Analyzer the First Time
and answers about the End-User License Agreement topic in the Microsoft Windows XP Help and 
Support Center.

If you have connected a USB mouse, position the cursor appropriately and use the left mouse button 
to navigate the License Agreement screen. 

If you do not have a mouse available to navigate the screen, then use the instrument front panel 
keys as follows:

1. Press the Tab key to select the License Agreement text box.

2. Use the up and down arrow keys, or rotate the knob to read the agreement.

3. Press the Tab key again. This accesses I don't accept this agreement. You need to press the 
up arrow to select I accept this agreement.

4. Press Select, or Tab then Enter to finish this screen and move to the Date and Time Settings 
screen.

Setting System Date and Time

The Date and Time Settings screen is used to set the appropriate date, time and time zone If you 
have connected a USB mouse, position the cursor and use the left mouse button to navigate the 
Date and Time Settings screen. Alternatively, the procedure for navigating this screen using a USB 
keyboard or the front panel is as follows:

1. Press the Tab (tab right or tab left) key to move between items in the Date and Time Settings 
screen. (The settings include the Date, Time, and Time Zone boxes, the Automatically adjust 
clock for daylight saving changes check box, and the Next button).

2. Use the left and right arrow keys to move between different parts of the item (for example, 
month, day, year, and hour, minute, seconds).

3. Use the up and down arrow keys to scroll through the different values available for the selected 
item (for example, month, day).

4. Use the Space key to select or clear the "Automatically adjust clock for daylight saving 
changes" check box when it is the active item.

5. When you have completed the date and time settings, press Enter, or Tab then Enter to finish this 
screen and continue the Windows XP Setup Wizard.

Anti-virus Software and Firewalls

No anti-virus software is shipped with the instrument. It is recommended that you install 
anti-virus software if your instrument will be connected to the LAN. Check with your IT 
department for their recommendations. See the section “3rd Party Software Verified by Agilent” on 
page 34 for information about software that has been tested by Agilent.

The instrument is shipped with the Windows XP firewall enabled. Do not modify the default 
network settings as this may cause the instrument to not operate properly.
Chapter 1 9
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Turning on the Analyzer the First Time
Shortening the Instrument Power-on Time

The instrument desktop includes a shortcut to the MXA ConfigureApplications.exe application that 
lets you control your instrument power-on configuration. You can set the configuration to pre-load 
only the application(s) that you typically run. This can significantly shorten the time it takes for 
your instrument to power-on.

If (after power-on) you want to access a Mode/application that you did not pre-load, it will take a 
little longer to bring it up once you press the button under the Mode key. This longer time frame is 
only for the first access after power-on. After the initial access, Mode switching will operate as 
quickly as if the Mode was pre-loaded.
Chapter 110
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Navigating Windows Without a Mouse
Navigating Windows Without a Mouse

See also the section "Windows Shortcuts and Miscellaneous Tasks" in the Getting Started Guide 
chapter on Using Microsoft Windows XP.

Key Presses Actions

Esc Exits/closes a Windows dialog box (does not exit an Application window)

Enter Does the current "default action". If a menu item or a button is currently 
"highlighted", then the Enter key will activate that menu item or button.

Alt Moves focus/control to the pull down menus bar in the active Window

Right Arrow In pull-down menu: opens the next menu to the right, or opens a submenu

In a dialog box: selects an option button

Left Arrow In pull-down menu: opens the next menu to the left, or opens a submenu

In dialog box: selects an option button

Up Arrow In pull-down menu: Moves to next selection up in the menu

In dialog box: selects an option button

Down Arrow In pull-down menu: Moves to next selection down in the menu

In dialog box: selects an option button

Tab In dialog box: moves to the next/previous field

Del Deletes the currently selected item

Alt + Tab Switches between the next/previous Application

Alt + Enter Shows the Properties of the currently selected item

Alt + Esc Cycles through items in the order that they had been opened

Backspace In My Computer or Windows Explorer: move up one level

In Internet Explorer: works like the BACK arrow key

Ctrl + Left arrow Moves to the left one word at a time

Ctrl + Right arrow Moves to the right one word at a time

Ctrl + Tab In dialog box: moves to the next/previous Tab location

Alt + Space Opens the window control menu for the currently active window, allowing 
you to minimize, maximize, move and restore (size) the window

Ctrl + Esc Opens the Windows Start Menu

Ctrl + Alt + Delete Opens the Windows Task Manager
Chapter 1 11
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Power Requirements
Power Requirements
The only physical installation of your Agilent spectrum analyzer is a connection to a power source. 

Line voltage does not need to be selected.

This analyzer does not contain customer serviceable fuses.

WARNING This is a Safety Class 1 Product (provided with a protective earthing ground 
incorporated in the power cord). The mains plug shall only be inserted in a 
socket outlet provided with a protective earth contact. Any interruption of 
the protective conductor inside or outside of the product is likely to make 
the product dangerous. Intentional interruption is prohibited. (IEC 348 
clauses 17.3.3c & 17.3.4) 

Failure to ground the analyzer properly can result in personal injury. Before 
turning on the analyzer, you must connect its protective earth terminals to 
the protective conductor of the main power cable. Insert the main power 
cable plug into a socket outlet that has a protective earth contact only. DO 
NOT defeat the earth-grounding protection by using an extension cable, 
power cable, or autotransformer without a protective ground conductor.

CAUTION This product is designed for use in Installation Category II and Pollution Degree 2 per 
IEC 61010 Second Edition and IEC 664 respectively. 

This instrument has autoranging line voltage input. Be sure the supply voltage is 
within the specified range.

The Mains wiring and connectors shall be compatible with the connector used in the 
premise electrical system. Failure, to ensure adequate earth grounding by not using 
the correct components may cause product damage, and serious injury.

AC Power Cord

The analyzer is equipped with a three-wire power cord, in accordance with international safety 
standards. This cable grounds the analyzer cabinet when connected to an appropriate power line 
outlet. The cable appropriate to the original shipping location is included with the analyzer.

Various AC power cables are available that are unique to specific geographic areas. You can order 
additional AC power cables for use in different areas. AC Power Cords, on page 16 lists the 
available AC power cables, illustrates the plug configurations, and identifies the geographic area in 
which each cable is appropriate.

WARNING If this product is not used as specified, the protection provided by the 
equipment could be impaired. This product must be used in a normal 
condition (in which all means for protection are intact) only.
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Power Requirements
Install the instrument so that the detachable power cord is readily 
identifiable and easily reached by the operator. The detachable power cord 
is the instrument disconnecting device. It disconnects the mains circuits 
from the mains supply before other parts of the instrument. The front panel 
switch is only a standby switch and is not a LINE switch. Alternatively, an 
externally installed switch or circuit breaker (which is readily identifiable 
and is easily reached by the operator) may be used as a disconnecting device.

CAUTION Always use the three-prong AC power cord supplied with this product. Failure to 
ensure adequate earth grounding by not using this cord can cause product damage.
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AC Power Cords
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Instrument Location and Rack Mounting Requirements

Locating the Instrument

Make sure that both the fan inlet area and the exhaust vent area are not obstructed. The minimal 
clearance required is 2 inches for these vents on the sides of the instrument. Lack of adequate 
clearance can result in excessive audible noise. This is because airflow restrictions cause additional 
airflow noise and cause the fans to speed up so they can draw in enough air for the required cooling.

Cooling and Rack Mounting

Do not rack mount the MXA Signal Analyzer side by side with another MXA Signal Analyzer, or an 
instrument with side to side ventilation. Make sure that the exhaust air from the first instrument is 
directed away from the inlet of the second unit. If the pre-heated air from the first instrument is 
directed into the second instrument, it results in excessive operating temperatures in the second 
unit and can cause instrument failures.
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Instrument Maintenance

Cleaning the Instrument

WARNING To prevent electrical shock, disconnect the Agilent Technologies model 
N9020A from mains before cleaning. Use a dry cloth or one slightly 
dampened with water to clean the external case parts. Do not attempt to 
clean internally.

Battery Information

The analyzer uses a lithium battery located on the CPU board. This is not an operator replaceable 
part. See “Returning an Analyzer for Service” on page 91. Replaceable parts must be approved or 
supplied by Agilent Technologies.

You can order the service documentation for the instrument through your Agilent Sales and Service 
office. 

WARNING Danger of explosion if battery is incorrectly replaced. Replace only with the 
same or equivalent type recommended. Discard used batteries according to 
the manufacturer’s instructions.

Do not throw batteries away but collect as small chemical waste.
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Protecting Against Electrostatic Discharge
Electrostatic discharge (ESD) can damage or destroy electronic components (the possibility of 
unseen damage caused by ESD is present whenever components are transported, stored, or used).

Test Equipment and ESD

To help reduce ESD damage that can occur while using test equipment:

• Before connecting any coaxial cable to an analyzer connector for the first time each day, 
momentarily short the center and outer conductors of the cable together.

• Personnel should be grounded with a 1 MΩ resistor-isolated wrist-strap before touching the 
center pin of any connector and before removing any assembly from the analyzer.

• Be sure that all instruments are properly earth-grounded to prevent build-up of static charge.

WARNING Do not use these first three techniques when working on circuitry with a 
voltage potential greater than 500 volts.

• Perform work on all components or assemblies at a static-safe workstation.

• Keep static-generating materials at least one meter away from all components.

• Store or transport components in static-shielding containers.

• Always handle printed circuit board assemblies by the edges. This reduces the possibility of ESD 
damage to components and prevent contamination of exposed plating.

Additional Information about ESD

For more information about ESD and how to prevent ESD damage, contact the Electrostatic 
Discharge Association (http://www.esda.org). The ESD standards developed by this agency are 
sanctioned by the American National Standards Institute (ANSI).
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Trademark Acknowledgements
Microsoft ® is a U.S. registered trademark of Microsoft Corporation.

Windows ® and MS Windows ® are U.S. registered trademarks of Microsoft Corporation.

Adobe Reader ® is a U.S. registered trademark of Adobe System Incorporated.

Java™ is a U.S. trademark of Sun Microsystems, Inc.

MATLAB ® is a U.S. registered trademark of Math Works, Inc.

Norton Ghost™ is a U.S. trademark of Symantec Corporation.
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2 Front and Rear Panel Features
• “Front Panel Features” on page 22

• “Display Annotations” on page 26

• “Rear-Panel Features” on page 28

• “Front and Rear Panel Symbols” on page 30
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Front Panel Features

Front-Panel Connectors and Keys

Item
Description

# Name

1 Menu Keys Key labels appear to the left of the menu keys to identify the current function of each 
key. The displayed functions are dependent on the currently selected Mode and 
Measurement, and are directly related to the most recent key press.

2 Analyzer 
Setup Keys

These keys set the parameters used for making measurements in the current Mode 
and Measurement.

3 Measurement 
Keys

These keys select the Mode, and the Measurement within the mode. They also control 
the innitiation and frequency of measurement.

4 Marker Keys Markers are often available for a measurement, to measure a very specific 
point/segment of data within the range of the current measurement data.

5 Utility Keys These keys control system-wide functionaliy like:

•  instrument configuration information and I/O setup,
•  printer setup and printing,
•  file management, save and recall,
•  instrument instrument presets.

6 Probe Power Supplies power for external high frequency probes and accessories.
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7 Headphones 
Output

Headphones can be used to hear any available audio output.

8 Back Space 
Key

Press this key to delete the previous character when entering alphanumeric 
information. It also works as the Back key in Help and Explorer windows.

9 Delete Key Press this key to delete files, or to perform other deletion tasks.

10 USB 
Connectors

Standard USB 2.0 ports, Type A. Connect to external peripherals such as a mouse, 
keyboard, DVD drive, or hard drive.

11  
Local/Cancel/
(Esc) Key

If you are in remote operation, Local: 

• returns instrument control from remote back to local (the front panel). 
• turns the display on (if it was turned off for remote opperation). 
• can be used to clear errors. (Press the key once to return to local control, and a 

second time to clear error message line.)

If you have not already pressed the units or Enter key, Cancel exits the currently 
selected function without changing its value.

Esc works the same as it does on a pc keyboard. It: 

• exits Windows dialogs
• resets input overloads
• clears errors
• aborts printing
• cancels operations.

12 RF Input Connector for inputing an external signal. Make sure that the total power of all 
signals at the analyzer input does not exceed +30 dBm (1 watt).

13 Numeric 
Keypad

Enters a specific numeric value for the current function. 

14 Enter and 
Arrow Keys

The Enter key terminates data entry when either no unit of measure is needed, or 
you want to use the default unit.

The arrow keys:

• Increment and decrement the value of the current measurement selection.
• Navigatie help topics.
• Navigate, or make selections, within Windows dialogs.
• Navigate within forms used for setting up measurements.
• Navigate within tables.

NOTE The arrow keys cannot be used to move a mouse pointer around on 
the display.

15 Menu/ (Alt) 
Key

Alt works the same as a pc keyboard. Use it to change control focus in Windows 
pull-down menus.

16 Ctrl Key Ctrl works the same as a pc keyboard. Use it to navigate in Windows applications, or 
to select multiple items in lists.

Item
Description

# Name
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Overview of Key Types

The keys labeled FREQ Channel, System, and Marker Function are all examples of front-panel keys. 
Most of the dark or light gray keys access menus of functions that are displayed along the right side 
of the display. These displayed key labels are next to a column of keys called menu keys.

Menu keys list functions based on which front-panel key was pressed last. These functions are also 
dependant on the current selection of measurement application (Mode) and measurement (Meas). 

If a menu key function’s numeric value can be changed, it is called an active function. The function 
label of the active function is highlighted after that key has been selected. The displayed value 
indicates that the function is selected and its value can now be changed using any of the data entry 
controls.

Some menu keys have multiple choices on their label like On/Off or Auto/Man. The different choices 
are selected by pressing the key multiple times. Take an Auto/Man type of key as an example. To 
select the function, press the menu key and notice that Auto is underlined and the key becomes 
highlighted. To change the function to manual, press the key again so that Man is underlined. If 

17 Select / Space 
Key

Select is also the Space key and it has typical pc functionality. For example, in 
Windows dialogs, it selects files, checks and unchecks check boxes, and picks radio 
button choices. It opens a highlighted Help topic.

18 Tab Keys Use these keys to move between fields in Windows dialogs.

19 Knob Increments and decrements the value of the current active function.

20 Return Key Exits the current menu and returns to the previous menu. Has typical pc 
functionality.

21 Full Screen 
Key

Pressing this key turns off the softkeys to maximize the graticule display area.

22 Help Key Initiates a context-sensitive Help display for the current Mode. Once Help is 
accessed, pressing a front panel key brings up the help topic for that key function.

23 Speaker 
Control Keys

Enables you to increase or decrease the speaker volume, or mute it.

24 Window 
Control Keys

These keys select between single or multiple window displays. They zoom the current 
window to fill the data display, or change the currently selected window. They can be 
used to switch between the Help window navigation pane and the topic pane.

25 Power 
Standby 
On/Off

Turns the analyzer on. A green light indicates power on. A yellow light indicates 
standby mode.

NOTE The front-panel switch is a standby switch, not a LINE switch 
(disconnecting device). The analyzer continues to draw power even 
when the line switch is in standby. 

The main power cord can be used as the system disconnecting device. 
It disconnects the mains circuits from the mains supply.

Item
Description

# Name
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there are more than two settings on the key, keep pressing it until the desired selection is 
underlined. 

When a menu first appears, one key label will be highlighted to show which key is the default 
selection. Some of the menu keys are grouped together by a yellow bar running behind the keys 
near the left side. When you press a key within the yellow bar region the highlight will move to that 
key to show it has been selected. The keys that are linked by the yellow bar are related functions, 
and only one of them can be selected at any one time. If the current menu is two pages long, the 
yellow bar could include keys on the second page of keys.

In some key menus, a key label will be highlighted to show which key has been selected from 
multiple available choices. And the menu is immediately exited when you press one of the other 
keys. 

If a displayed key label shows a small solid-black arrow tip pointing to the right, it indicates that 
additional key menus are available. If the arrow tip is not filled in solid then pressing the key the 
first time selects that function. Now the arrow is solid and pressing it again will bring up an 
additional menu of settings.
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Display Annotations
The following graphic is an example of an N9060A Spectrum Analyzer display. Your instrument 
display may look different.

Item Description Function Keys 

1 Measurement bar - Shows general measurement settings 
and information.

Indicates single/continuous measurement.

Some measurements include limits that the data is tested 
against. A Pass/Fail indication may be shown in the lower 
left of the measurement bar.

All the keys in the Analyzer Setup part of 
the front panel.

2 Active Function (measurement bar) - when the current 
active function has a settable numeric value, it is shown 
here.

Currently selected front panel key.
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3 Banner - shows the name of the selected measurement 
application and the measurement that is currently running.

Mode, Meas

4 Measurement title (banner) - shows title information for the 
current Measurement, or a title that you created for the 
measurement.

Meas

View/Display, Display, Title

5 Settings panel - displays system information that is not 
specific to any one application.

• Input/Output status - green LXI indicates the LAN is 
connected. RLTS indicate Remote, Listen, Talk, SRQ

• Input impedance and coupling
• Selection of external frequency reference
• Setting of automatic internal alignment routine

Local and System, I/O Config

Input/Output, Amplitude, System and others

6 Active marker frequency, amplitude or function value Marker

7 Settings panel - time and date display. System, Control Panel. . .

8 Trace/Detector panel (measurement bar) 

Type:  Detector:

W - clear/write  N - normal detection (rise and fall)

A - trace average  S - sample detection

M - max hold  P - positive peak detection

m - min hold  p - negative peak detection

  A - average detection

White = update on  f - math function

Gray = update off   

Srikethrough “W”   

means display off   

Trace/Detector

Trace: Identifies traces by color

Type: Shows trace mode setting, trace 
display on/off, and trace update on/off

Det: Shows detector selection or math 
function applied to the trace

9 Key labels that change based on the most recent key press. Softkeys

10 Displays information, warning and error messages. 
Message area - single events, Status area - conditions

11 Measurement settings for the data currently being 
displayed in the graticule area. In the example above: 
center frequency, resolution bandwidth, video bandwidth, 
frequency span, sweep time and number of sweep points.

Keys in the Analyzer Setup part of the 
front panel.

Item Description Function Keys 
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Rear-Panel Features

Item Description

# Name

1 EXT REF IN Input for a 1 to 50 MHz external frequency reference signal.

2 MONITOR Allows connection of an external VGA monitor. 

3 USB 
Connectors

Standard USB 2.0 ports, Type A. Connect to external peripherals such as a mouse, 
keyboard, printer, DVD drive, or hard drive.

4 USB 
Connector

USB 2.0 port, Type B. USB TMC (test and measurement class) connects to an 
external pc controller to control the instrument and for data transfers over a 480 
Mbps link.

5 LAN A TCP/IP Interface that is used for remote analyzer operation. 

6 GPIB A General Purpose Interface Bus (GPIB, IEEE 488.1) connection that can be used 
for remote analyzer operation. 

7 Line power 
input

The AC power connection. See the product specifications for more details.

8 Digital Bus Reserved for future use.

9 Analog Out Reserved for future use.

10 TRIGGER 2 
OUT

A trigger output used to synchronize other test equipment with the analyzer. 
Configurable from the Input/Output keys.

11 TRIGGER 1 
OUT

A trigger output used to synchronize other test equipment with the analyzer. 
Configurable from the Input/Output keys.

12 Sync Reserved for future use.
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13 TRIGGER 2 
IN

Allows external triggering of measurements.

14 TRIGGER 1 
IN

Allows external triggering of measurements.

15 Noise Source 
Drive +28 V 
(Pulsed)

Reserved for future use.

16 SNS Series 
Noise Source

Reserved for future use.

17 10 MHz OUT An output of the analyzer’s internal 10 MHz frequency reference signal. It is used to 
lock the frequency reference of other test equipment to the analyzer. 

Item Description

# Name
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Front and Rear Panel Symbols
  This symbol is used to indicate power ON (green LED).

  This symbol is used to indicate power STANDBY mode (yellow LED).

  This symbol indicates the input power required is AC.

  The instruction documentation symbol. The product is marked with this symbol 
when it is necessary for the user to refer to instructions in the documentation.

  The CE mark is a registered trademark of the European Community.

  The C-Tick mark is a registered trademark of the Australian Spectrum 
Management Agency.

  This is a marking of a product in compliance with the Canadian 
Interference-Causing Equipment Standard (ICES-001).

This is also a symbol of an Industrial Scientific and Medical Group 1 Class A 
product (CISPR 11, Clause 4).

  The CSA mark is a registered trademark of the Canadian Standards Association 
International.

  This symbol indicates separate collection for electrical and electronic equipment 
mandated under EU law as of August 13, 2005. All electric and electronic 
equipment are required to be separated from normal waste for disposal (Reference 
WEEE Directive 2002/96/EC).

To return unwanted products, contact your local Agilent office, or see 
http://www.agilent.com/environment/product/ for more information. 
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3 Instrument Configuration
This chapter describes the Microsoft Windows XP configuration and the settings used with the 
Agilent instrument software. It includes information about changing some of the system settings. 
And it describes the Windows operating system configuration and the software installations that 
are present on the Hard Disk Drive when the instrument leaves the factory.

The front panel of the analyzer has been designed with the keys needed to navigate windows for: 
accessing menus, traversing in dialogs, selecting items, and depressing displayed buttons. It is 
possible to use the front panel for changing Windows XP configuration items, but it is much easier 
to perform these tasks with a USB mouse and external keyboard. For specifics on navigating using 
the front panel, see the front panel description.

• “Navigating Windows Without a Mouse” on page 32

• “Agilent Software Installed” on page 33

• “Customer Installation of Software” on page 34

• “User Accounts” on page 35

• “Windows Configuration” on page 37

• “Configuring Printers” on page 40

• “Configuring LAN” on page 41

• “Windows Security” on page 42

• “System Maintenance” on page 46

• “USB Connections” on page 47

• “Hard Drive Partitioning and Use” on page 48

• “Hard Drive Recovery Process” on page 49
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Navigating Windows Without a Mouse

See also the section Windows Shortcuts and Miscellaneous Tasks in the Getting Started Guide 
chaper on Using Microsoft Windows XP.

Key Presses Actions

Esc Exits/closes a Windows dialog box (does not exit an Application window)

Enter Does the current "default action". If a menu item or a button is currently 
"highlighted", then the Enter key will activate that menu item or button.

Alt Moves focus/control to the pull down menus bar in the active Window

Right Arrow In pulldown menu: opens the next menu to the right, or opens a submenu

In a dialog box: selects an option button

Left Arrow In pulldown menu: opens the next menu to the left, or opens a submenu

In dialog box: selects an option button

Up Arrow In pulldown menu: Moves to next selection up in the menu

In dialog box: selects an option button

Down Arrow In pulldown menu: Moves to next selection down in the menu

In dialog box: selects an option button

Tab In dialog box: moves to the next/previous field

Del Deletes the currently selected item

Alt + Tab Switches between the next/previous Application

Alt + Enter Shows the Properties of the currently selected item

Alt + Esc Cycles through items in the order that they had been opened

Backspace In My Computer or Windows Explorer: move up one level

In Internet Explorer: works like the BACK arrow key

Ctrl + Left arrow Moves to the left one word at a time

Ctrl + Right arrow Moves to the right one word at a time

Ctrl + Tab In dialog box: moves to the next/previous Tab location

Alt + Space Opens the window control menu for the currently active window, allowing 
you to minimize, maximize, move and restore (size) the window

Ctrl + Esc Opens the Windows Start Menu

Ctrl + Alt + Delete Opens the Windows Task Manager
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Agilent Software Installed

Agilent Signal Analyzer Software

The N9060A Agilent Spectrum Analyzer Measurement Application software is installed in the 
N9020A MXA Signal Analyzer measurement platform. Additional measurement applications are 
available. Each application requires a license to execute the software. All of these applications are 
installed by the factory at the time of manufacture, even if the licenses have not been purchased. 
You may purchase additional licenses at a later date.

Agilent 89600

Agilent 89600 Flexible Demodulation is installed. Agilent 89600 measurements requires a license 
to use the product beyond an initial 14 day trial period.
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Customer Installation of Software

3rd Party Software Verified by Agilent

Agilent has verified that the following programs are compatible with the instrument applications:

• Symantec AntiVirus™ Corporate Edition version 9.0.0.338

• MathWorks MATLAB

Installation of Other 3rd Party Software

The N9020A is an Open Windows environment, so you can install non-approved software on the 
instrument. However, installation of non-approved software may affect instrument performance. 
Agilent does not warrant the performance of the N9020A with non-approved software installed.

NOTE Before installing any additional programs on the instrument, you should exit the 
Signal Analyzer application.

Also, you must not remove any applications or programs that are installed on the 
instrument when it is shipped from the factory.

If you install programs other than those which Agilent has tested, it could cause problems with the 
instrument's applications. If this happens, you should try uninstalling the program that has caused 
the problem, or try changing the program's configuration. If this does not correct the problem, you 
may have to use the Agilent Recovery system to reinstall the instrument's system software.
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User Accounts

Administrator Login

The Administrator account ships from the factory with the password “agilent4u”. Using the 
Administrator account you can perform the following operations:

• Install software

• Configure network and printer access

• Access all files on the instrument

• Add or change user accounts and passwords

• Change Windows settings

• Run any application

User Login

The default user account that ships from the factory is “Instrument” with the password 
“measure4u”. This user is a member of the Power Users group. Using the Instrument account you 
can perform the following operations:

• Install software

• Configure network and printer access

• Access files on the instrument that are accessible to the Power Users group

• Run applications that are accessible to the Power Users group

AgilentOnly user account

The instrument contains a user account called “AgilentOnly” that can be used by Agilent’s customer 
support in the event that the Administrator password was changed and has since been 
lost/forgotten. You must not remove or modify the AgilentOnly account.

Agilent Service user accounts

User accounts are defined for Agilent’s use if it is necessary to service the instrument.

Customer creation of accounts

You can create additional user accounts and decide on the level of security granted to any new user 
accounts created. For example, the level of security can be assigned as administrator, power user, 
user, backup operators. User names are not case sensitive but passwords are case sensitive.

NOTE For the Signal Analyzer software to operate the user account executing the software 
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must be assigned Administrator or Power User privileges. Otherwise, the Signal 
Analyzer software will not operate correctly. 

It is Agilent’s expectation that each user’s My Documents folder is mapped to the D: drive. This is to 
avoid overwriting the user’s data in the event the Agilent Recovery must be performed. Also, this 
facilitates convenient backup by copying the contents of the D: drive to external media. All users 
accounts created by the factory already have My Documents mapped to the D: drive. Please map all 
new users My Documents folders to the D: drive.
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The Windows settings have been optimized for the best measurement performance. Any 
modifications to these settings may degrade instrument performance and measurement speed. In 
general, most Windows System settings (typically set through the Windows Control Panel) should 
not be modified. Those that can be safely modified are listed below.

CAUTION To recover from problems caused by changing Windows systems settings, you may 
have to reinstall the Windows system and instrument application using the Agilent 
Recovery process.

Settings That Can Be Changed

You may change the following Windows settings or administrative tasks (available from the 
Windows Control Panel) to select your personal preferences. 

NOTE Before changing any Windows System settings, exit the instrument application. 

You May Use 
This Feature

To Do This . . . 

Configure Microsoft Automatic Updates.

Install and configure an Anti Virus program.

Setup new Instrument user accounts.

CAUTION Do not delete or modify the  "Agilent-Only" user account
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Settings That Must Not Be Changed

Avoid changing any settings in this section. Changes to the following settings may degrade 
instrument performance, screen displays, and measurement speed.

Add the Instrument to a network.

Install and configure a printer.

Set the time and date.

Modify System Properties, Advanced Tab settings of Performance, Adjust for 
Best Performance. Leave all other settings unchanged.

Do NOT Use 
This Feature

To Do This . . . 

Do not change Power Options. (Power Scheme, Power Button, Hibernate)

Do not modify System Properties, Hardware Tab settings (Device Manager, 
Drivers).

Do not modify System Properties, Advanced Tab settings (Performance, User 
Profiles, Startup and Recovery, Environment Variables, Error Reporting)

You May Use 
This Feature

To Do This . . . 
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Do not remove installed Fonts.

Do not change the following Display Settings:

• Screen Saver settings
• The screen resolution, 1024 x 768
• DPI setting from Normal size (96 DPI)

Do not delete or modify the "AgilentOnly" user account.

In addition, DO NOT:

• Add, delete, or modify hard-disk drive partitions.

• Delete or modify Agilent registry entries.

• Change the contents of any directories containing the name "Agilent"

• Stop these services:

— The MSSQL$CDF service or uninstall the "Microsoft SQL Server Desktop Engine"
— The IIS server or tamper with any virtual directories (or their contents) that came 

configured with the instrument.

• Uninstall these libraries, interfaces, or programs:

— The Agilent I/O Libraries
— The .NET Framework or any Hotfixes or Service Packs for the .NET Framework
— The "Microsoft Visual J# .NET Redistributable Package 1.1"
— Programs that begin with "Agilent"
— The Adobe Acrobat Reader

• Modify

— The Agilent I/O Library "GPIB27", "GPIB28" interfaces shown as configured Instrument 
I/O in the Agilent Connection Expert or I/O Config.

Do NOT Use 
This Feature

To Do This . . . 
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Configuring Printers
Printers are configured using the Microsoft Windows Control Panel. It is easily accessed from the 
Windows Start menu or from under the front panel System key. This setup process is most easily 
done using a USB Mouse and an External Keyboard. If you don’t have a mouse it can be done using 
front panel keys, and you might want to reference the section on “Navigating Windows Without a 
Mouse” on page 32.

When setting up a new printer, you may need to load the printer driver (unless you are using a 
network printer that your IT department has set up to include the driver). The manufacturer of the 
printer supplies the driver software and process. That may require that you attach an external USB 
disk drive. An alternative is to connect the instrument to the LAN and download the driver from 
the printer manufacturer’s internet site.
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Configuring LAN

Hostname

The Computer Name, or hostname, is pre-configured from the factory. It must be a unique name 
such that it will not conflict with other equipment on your LAN. The pre-configured Computer 
Name is A-N9020A-xxxxx, where xxxxx is the last 5 digits of the instrument’s serial number.

To change the Computer Name consult the Microsoft Windows XP Help and Support Center.

IP Address & Gateway

The instrument is pre-configured to obtain an IP Address using DHCP. The IP Address and 
Gateway can be changed. Consult the Microsoft Windows XP Help and Support Center to configure 
the LAN.
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Microsoft recommends the following three steps to ensure the instrument's Windows XP operating 
system is protected:

1. Use an internet firewall.

2. Get the latest critical Windows updates.

3. Use up-to-date antivirus software.

To check the status or make changes in the security settings for you instrument, open the Windows 
Security Center, click Start, Control Panel, and then click Security Center.

NOTE The window may look slightly different on your instrument.
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Windows Firewall

The instrument is shipped with the Windows Firewall enabled.

NOTE The window may look slightly different on your instrument.

Windows Firewall Exceptions for programs and ports have been added to allow proper operation of 
the instrument over a network. Modifying these settings may cause the instrument to not operate 
properly.

Automatic Updates

The default instrument setting is to automatically check for critical Windows Updates, notify you, 
download the updates and install them, if the instrument has internet access.

You can change the configuration of the Microsoft Automatic Updates. You can choose not to have 
automatic updates. Then you can manually update Windows by accessing Internet Explorer and 
from the Tools menu select Windows Update.
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NOTE Be aware that downloading and installing Windows Updates can be network and CPU 
usage intensive (impacting the instrument performance) and some Windows Updates 
will automatically reboot the instrument. It is recommended that Windows Updates be 
performed when the instrument is not in normal use.

Virus Protection

There is no antivirus software included with your instrument. Antivirus application software has 
been tested to be compatible with the instrument. See the section on 3rd Party Software Verified by 
Agilent in the Instrument Configuration chapter for Anti-Virus software that has been tested by 
Agilent.

NOTE Having antivirus software installed may have a slight impact on the instrument 
performance.
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Spyware Protection

There is no anti-spyware software installed on the instrument. But as long as you don’t use the 
instrument for a lot of internet browsing, this should not be a problem. However, having spyware in 
the instrument could have an impact on the instrument performance.
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Backup

It is recommended that you have a regular backup strategy. Your IT department may already have 
a backup strategy in place which is suitable for the instrument and its data. Using the Agilent 
Recovery system in conjunction with a regular backup strategy should allow full recovery of the 
instrument data.

Windows XP has a Backup utility that you can use to archive files and folders in case of a hard disk 
drive failure. See the Microsoft Windows XP Help and Support Center for more information on this 
utility. You can also use third party backup utilities. However, you must ensure that this third party 
software is compatible with the instrument's system software. See Customer Installation of 
Software for more information.

When performing backups, we recommend that you backup the data to an external storage device 
connected to the network or one of the instrument's USB connectors. Also, you should perform 
backups at times when the instrument is not being used for normal operations as it may impact the 
instrument's overall performance.

System Restore

Windows XP contains capability to restore the system to a previous point in time. System Restore is 
enabled with default settings as provided by Microsoft. However, System Restore is not 100% 
successful. Therefore it is not the recommended method to backup the instrument. System Restore 
has not been tested to verify successful restoring.

Disk Defragmenting

Over time the instrument’s hard disk will become fragmented. Windows XP has a Disk 
Defragmenter utility that you can use to defragment the hard disk. See the Microsoft Windows XP 
Help and Support Center for more information on this utility. 

NOTE Running Disk Defragmenter should be performed when the measurement application 
is not running. Measurement throughput will be significantly impacted while disk 
defragmentation is in process.
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USB Connections
All of the USB ports are compatible with the USB 2.0 and 1.1 specification. The two USB ports on 
the front panel (see graphic below) and four of the USB ports on the rear panel are USB Series "A" 
ports. These are ports to which you can connect USB mass storage devices and printers. The 
instrument USB Host support includes the standard Microsoft Windows XP USB class drivers for 
human interface, mass storage, printing, and scanning/imaging devices. A complete and up to date 
list of the Windows XP USB class driver support is available on the Microsoft website.

http://www.microsoft.com/whdc/system/bus/usb/USBFAQ_intro.mspx

The square USB port (see graphic below) on the rear panel is a USB Series "B" port and is used for 
controlling the instrument over USB. Information to help you program your instrument is 
documented in the N9060A User's Guide. The instrument USB Device driver included in the 
instrument software supports the test and measurement industry standard USBTMC-USB488 
device class. 

In addition, the Agilent IO Libraries CD that was included with your instrument contains USB 
Host drivers that allow control of other instruments connected to the USB bus.

Agilent Technologies does not support or warrant correct instrument operation if additional USB 
drivers from third parties are installed in the instrument. It is possible that additional drivers could 
break the normal USB operation. If USB operation is broken, recovery would require reinstalling 
the instrument application using the hard drive recovery process. 
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Hard Drive Partitioning and Use
The drive is partitioned into 3 sections: C:, D: and E:

• The C: partition contains the Windows XP operating system and software installed by Agilent. 
This is an Open System which means you can install additional software, and these should be 
installed on the C: drive. However, only a limited set of software applications are tested for use 
with the Agilent measurement software. The installation and/or use of other software is not 
warranted, and could interfere with the operation of the measurement software. If instrument 
repair is ever needed, the Agilent version of the C: drive is the only part of the instrument 
software that is restored by the Agilent Recovery process. You will have to reload any other 
software that you have added in the instrument.

• The D: partition is reserved for data storage. The User Accounts that are configured by Agilent 
have their My Documents folder mapped to the D: drive. This is for the convenience of 
backing-up the measurement data. You should always back-up the data on the D: drive to an 
external device. This allows you to restore the data if you ever need to replace the hard drive.

• The E: partition is reserved for Agilent’s use. The primary use of the E: drive is for housing the 
Calibration and Alignment data. Do not change or overwrite the files on this drive. This could 
cause your instrument to not meet specifications, or even to stop functioning correctly. Do not 
use this drive for data storage. It is also recommended that you back up the contents of this drive 
to an external device.
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Hard Drive Recovery Process
The Agilent Recovery System can be used to repair errors on the instrument's C: drive partition, or 
to restore the original factory configuration of the system software. The Agilent Recovery System is 
stored in a separate hidden hard disk drive partition.

Repairing errors on the hard disk drive may result in loss of data or files. If you need more 
information about the Windows  “chkdsk”  error repair process, see the chkdsk documentation in 
the Microsoft Windows XP Help and Support Center.

Restoring the original factory system software does not restore any of the following items:

• Windows system configurations that were made after the instrument was shipped from the 
factory. For example, Windows and Service Pack updates, user accounts, and windows 
configuration settings. After an Agilent Recovery, these configurations will have to be redone.

• Additional software that was installed after the instrument was shipped from the factory. After 
an Agilent Recovery, that software will need to be re-installed.

• Any data or programs saved on the D: or E: drives.

• Any upgrades that were made to the Agilent measurement application software.

NOTE It is recommended that you use a regular back up strategy. Your IT department may 
already have a back up strategy in place which is suitable for the instrument and its 
data. See the System Maintenance section. Using the Agilent Recovery System in 
conjunction with a regular back up strategy should allow you to fully recover the 
instrument software and data.

It is recommended that routine backups of the instrument information be performed to keep 
current archives of the instrument information. This will allow a full recovery of the instrument 
information after the instrument recovery system operations are performed.   See the "Backing Up 
the Instrument Information" section for more details.

Using the Instrument Recovery System:

1. Make sure the instrument is turned off.

2. Turn on the instrument.
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3. After the "Agilent Technologies" screen is displayed

Then the following screen contents will be displayed for 3 seconds.

4. Press the down arrow key to move the highlight to "Agilent Recovery System", press the Enter 
key.

5. When the Agilent Recovery System has booted, follow the on-screen instructions to perform the 
desired recovery operations.

6. After exiting the Agilent Recovery System, the instrument will reboot. If the original factory 
instrument system has been restored, the instrument will re-execute the “Turning on the 
Analyzer the First Time” on page 8 process.

     Please select the operating system to start:

          Microsoft Windows XP Professional

          Agilent Recovery System

     Use the up and down arrow keys to move the highlight to your choice.

     Press Enter to choose.
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7. Additional recovery steps may be required to fully recover the system to a more current working 
state. This could involve restoring your own backups of the instrument configuration, including 
re-installing applications, data, and performing system customizations.

Configuring Recovery Prompt Timing

You can configure the time at which the instrument power-up process waits for the selection of the 
recovery process by performing the following steps: 

1. Get to My Computer, Properties

2. Select “Advanced” tab

3. In the “Startup and Recovery” section, select “Settings”

4. Under the “System Startup” section, you can either uncheck “Time to display list of operating 
systems:” or change the seconds to delay for it. 

NOTE You must be logged in as an admisistrator in order to change these settings. See “User 
Accounts” on page 35 for more information.
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4 Using Microsoft Windows XP
NOTE The capabilities described in this section are Microsoft Windows XP features. The 
discussion provided here gives some guidelines for using the capabilities with the 
instrument. You will have to refer to the Windows XP help documentation for more 
information. Your version of Windows, may not match these instructions exactly.

You need an external keyboard and mouse to fully use these features.

“Remote Desktop: Using the N9020A Remotely” on page 54

“Embedded Web Server: Using the N9020A Remotely” on page 67

“Capturing/Printing Displays and Windows” on page 81

“Windows Shortcuts and Miscellaneous Tasks” on page 82
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Remote Desktop: Using the N9020A Remotely
Windows Remote Desktop is recommended for remote control of the Instrument. It offers 
fully-interactive control, that is almost identical to direct face-to-face control of the instrument. You 
can also remotely control the instrument using the Embedded Web Server interface. The Embedded 
Web Server functionality provides a communications method that does not require login to the 
Instrument. However, due to its slower response time, it is only recommended for setup and data 
exchanges that do not involve instrument control.

NOTE The Remote Desktop functionality is a Microsoft Windows XP capability. The following 
discussion provides some guidelines for using this capability with the instrument. You 
will have to refer to the Windows XP help documentation for more information. As 
Windows evolves, these instructions may no longer be exact.

You need an external keyboard and mouse to fully use this functionality.

Overview of Remote Desktop Operation

Using the Remote Desktop functionality of the Instrument allows you to control and interact with 
the Instrument from a remote computer, as though you were sitting in front of the Instrument.

When you have configured the Instrument for remote connectivity, and configured a separate 
computer to act as a Remote Desktop Host, you can send commands to the Instrument from the 
Remote Computer, and you can see the Instrument Display on the screen of the Remote Computer.

This Section provides full details of how to set up the Instrument for remote connectivity, and also 
how to set up a computer running any 32-bit version of Microsoft Windows as a Remote Desktop 
Host.

Figure 4-1.  Basic Setup for Remote Desktop Operation
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Setting Up Remote Desktop Operation

Setting Up the Instrument

Before the Instrument may be controlled via a Remote Desktop Connection, it must be set up to 
allow connection from a remote computer. 

NOTE To perform this operation successfully, you must have Administrator level access to the 
Instrument.

To perform setup, do the following:

1. Open the Windows Control Panel, by either:

• from the Instrument Application, pressing System, Control Panel..., or, 

• from the Windows Desktop, clicking Start, Control Panel.

2. If the Control Panel appears with “Category View”, click Performance and Maintenance, then click 
System. If the Control Panel appears with “Classic View”, double-click System.

3. Select the Remote Tab of the System dialog.

4. A Warning Message appears, informing you that it may be necessary to configure your internet 
connection sharing or personal firewall to permit Remote Desktop connections. The details of 
such configuration are beyond the scope of this document.

5. In the “Remote Desktop” section of the dialog, check the “Allow users to connect remotely to this 
computer” checkbox. 

6. Click the “Select Remote Users...” button, then follow the onscreen instructions to add users. All 
users who have Administrative level access are listed as already having permission.

Setting Up the Remote Computer

The procedure depends on whether the Remote Computer to be set up is running Windows XP, or 
another version of Microsoft Windows.

Remote Computer running Windows XP  Windows XP includes the Remote Desktop 
Connectivity Client software, so no additional setup is required.

Remote Computer running another Version of Windows  You can use any 32-bit version of 
Windows (Windows 95, 98, ME, NT4, or 2000) to install and run the Client software for Remote 
Desktop Connectivity. However, you need to have available a Windows XP installation CD-ROM, 
because that contains the Client software.

NOTE The following instructions relate to software provided by Microsoft Corporation. 
Agilent offers no warranty regarding the operation of such software. The procedure 
described here may be changed by Microsoft at some future time.

To install the Client software, do the following:
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1. When the Welcome Screen appears, select Perform additional tasks.

2. From the “What do you want want to do?” screen, select Set up Remote Desktop Connection.

3. The “Remote Desktop Connection InstallShield Wizard” appears. Click Next to begin the 
installation, and follow the onscreen instructions provided by the Wizard.

4. Once the Remote Desktop Client Software is installed, you can access it via the Windows Start 
menu, under All Programs > Accessories > Communications > Remote Desktop Connection.

Running a Remote Desktop Session

Initializing a Remote Desktop Session

NOTE In order to initialize a Remote Desktop Session, you need to know the “Computer 
Name” of the Instrument. This information can be shown on the Instrument display by 
following the procedure in the Section “How To Locate the Computer Name of the 
Instrument” on page  65.

After setting up both the Instrument and the Remote Computer for Remote Desktop Connnectivity, 
as described in the Section “Setting Up Remote Desktop Operation” on page  55, you are ready to 
start a Remote Desktop session.

To start a Remote Desktop session from the remote computer:

1. Click Start > All Programs > Accessories > Communications > Remote Desktop 
Connection.

2. A Remote Desktop Connection dialog appears. 

In the box titled Computer, enter the Computer Name of the Instrument. (For instructions on 
how to obtain this, see the Section “How To Locate the Computer Name of the Instrument” on 
page  65.)

3. Click Connect.

4. Log in to the Instrument. In the login dialog that appears, enter the login account name and 
password. The default account name is “Instrument” and the default password is “measure4u,” 
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but note that these parameters may be changed by Instrument users.

NOTE Only the current User or an Administrator can remotely log into the instrument. To 
see who the current user of the instrument is, press Ctrl+Esc on the instrument until 
you can view the current user name on the Start menu. If no one is currently logged 
into the instrument, any valid instrument user can remotely log in.

5. The Instrument Display appears on the screen of the Remote Computer. Because the Instrument 
Front Panel keys are not available when using the Instrument remotely, three alternative 
methods are available to mimic the functions of the Front Panel keys, as detailed in the Sections, 
“Popup Menus for Remote Desktop Operation” on page  59, “The Virtual Front Panel” on page  
60, and “Keycode Commands for Remote Desktop Operation” on page  61. 

Setting Remote Desktop Options

Clicking the Options button in the Remote Desktop Connection dialog displays the Options dialog:

The Options dialog has several tabs. Generally, the default settings are correct. However, there are 
some restrictions on particular settings under certain tabs, as listed below.

• Under the General tab, ensure that the Computer Name, User name and Domain name are 
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correctly set. You may choose to enter the password and save it for future sessions, by checking 
the Save my password box.

• The information displayed under the Display tab is as shown below:

— Under Remote desktop size, you may select the size of the window in which the Instrument 
display will appear. Do not select any size smaller than 1024 x 768 pixels. Selecting a remote 
desktop size smaller than 1024 x 768 results in the Instrument display not being fully visible. 
In such circumstances, scroll bars do not appear, so portions of the display are not accessible.

— Under Colors, you may select any setting that uses 15 bits or more. Selecting a color setting 
that uses less than 15 bits results in dithering and incorrect color rendition of the remote 
desktop window.
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• The information displayed under the Experience tab is as shown below:

To optimize the peformance of the Remote Desktop session, choose the appropriate connection 
format from the drop-down listbox.

Ending a Remote Desktop Session

There are two ways to disconnect the remote computer from the Instrument, ending the Remote 
Desktop session.

1. If the remote desktop window is full-screen, click the X at the right of the connection bar that 
appears at the top center of the window. If the remote desktop window is not full-screen, click the 
red X box at the right of the window’s title bar. In both cases, a dialog appears, asking you to 
confirm that you wish to disconnect. Click OK to disconnect.

2. Move the cursor to the bottom left of the remote desktop window, to cause the taskbar to appear. 
Click Start, then click the red Disconnect button at the lower right of the Start menu (this 
corresponds to the Shut Down button in a non-remote Windows session). A dialog appears, 
asking you to confirm that you wish to disconnect. Click Disconnect to disconnect.

Popup Menus for Remote Desktop Operation

Right-clicking the mouse over the application display window pops up the following menu 
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hierarchy, which may be used as alternatives to the Front Panel keys.

The function of each selection in the popup menu is generally identical to that of the corresponding 
Front Panel key. There are certain additional items, as listed below:

• Exit. Selecting this item closes the Application software.

• Utility > Page Setup. Selecting this item opens a printer setup dialog.

• Utility > Virtual Front Panel. Selecting this item opens the Virtual Front Panel window, as 
described in the Section “The Virtual Front Panel” on page  60.

NOTE The popup menus are also available when using the Instrument directly, provided that 
a mouse or other pointing device is attached to it.

The Virtual Front Panel

The Virtual Front Panel is a software equivalent of the Front Panel key set, which provides a 
further alternate method for Instrument control. It may be displayed in a separate window on the 
Instrument (or Remote Desktop) display. 

NOTE The Virtual Front Panel is also available when using the Instrument directly, provided 
that a mouse or other pointing device is attached to it.

To display the Virtual Front Panel, right-click the mouse over the application display window, then 
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select Utility > Virtual Front Panel from the popup menu. The Virtual Front Panel appears, as 
shown below:

Clicking a button in the Virtual Front Panel mimics the operation of the corresponding Instrument 
Front Panel key. The buttons at the left of the panel, named Key 1 through Key 7, mimic the 
operation of the respective softkeys. The Rpg Up and Rpg Down keys mimic the operation of the 
Thumbwheel.

Keycode Commands for Remote Desktop Operation

When using the Instrument in Remote Desktop mode, the following combinations of remote 
keyboard keys can be used to mimic the operation of the Instrument Front Panel keys.
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Table 4-1. Keycode Commands

To mimic the following Front Panel key: Press these keys on the Remote 
Computer keyboard:

AMPTD Y Scale Ctrl+Shift+A

Auto Couple Ctrl+Shift+C

Bk Sp Backspace

BW Ctrl+Alt+B

Cancel (Esc) Esc

Cont Ctrl+Alt+C

Ctrl Ctrl

Decrease Audio Volume the Volume Control slider

Del Delete

Down Arrow Down Arrow

Enter Enter (Return)

File Ctrl+F

FREQ Channel Ctrl+Shift+F

Full Screen Ctrl+Shift+B

Help F1

Increase Audio Volume the Volume Control slider

Input/Output Ctrl+Shift+O

Left Arrow Left Arrow

Marker Ctrl+Shift+K

Marker -> Ctrl+Alt+N

Marker Function Ctrl+Alt+F

Meas Ctrl+Alt+M

Meas Setup Ctrl+Alt+U

Menu (Alt) Alt

Mode Ctrl+Shift+M

Mode Preset Ctrl+M

Mode Setup Ctrl+Alt+E
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Mute the Mute checkbox under the 
Volume Control

Next Window Ctrl+Shift+N

Peak Search Ctrl+Shift+P

Print Ctrl+P

Quick Save Ctrl+Shift+Q

Recall Ctrl+R

Restart Ctrl+Alt+R

Return Ctrl+Shift+R

Right Arrow Right Arrow

Save Ctrl+S

Select Space Bar

Single Ctrl+Alt+S

Softkey 1 Ctrl+Shift+F1

Softkey 2 Ctrl+Shift+F2

Softkey 3 Ctrl+Shift+F3

Softkey 4 Ctrl+Shift+F4

Softkey 5 Ctrl+Shift+F5

Softkey 6 Ctrl+Shift+F6

Softkey 7 Ctrl+Shift+F7

Source Ctrl+Shift+E

SPAN X Scale Ctrl+Shift+S

Split Screen Ctrl+Shift+L

Sweep/Control Ctrl+Shift+W

System Ctrl+Shift+Y

Tab Tab

Trace/Detector Ctrl+Alt+T

Trigger Ctrl+Shift+T

Up Arrow Up Arrow

Table 4-1. Keycode Commands

To mimic the following Front Panel key: Press these keys on the Remote 
Computer keyboard:
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NOTE The effect of pressing Ctrl+Alt+Delete on the keyboard of the remote computer always 
applies to the remote computer, and not to the Instrument. Generally, the effect of 
pressing this key combination is to display the Windows Task Manager. Therefore, 
pressing this key combination on the remote computer does not allow you to reboot the 
Instrument.

How To Locate the Computer Name of the Instrument

To connect a remote computer to the Instrument, you need to know its “Computer Name.” The 
Computer Name can be displayed as follows:

From the Agilent Application:

1. On the Instrument Front Panel, press System, Show, System.

User Preset Ctrl+U

View/Display Ctrl+Shift+V

Zoom Ctrl+Shift+Z

1 1a

2 2a

3 3a

4 4a

5 5a

6 6a

7 7a

8 8a

9 9a

– Use the – key to enter a negative 
value, as appropriatea

. (Decimal Point) . (Period)a

0 (Zero) 0 (Zero)a

a. For remote keyboards that feature a numeric keypad, use either the appropriate 
numeric keypad key or the main keypad key.

Table 4-1. Keycode Commands

To mimic the following Front Panel key: Press these keys on the Remote 
Computer keyboard:
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2. A page listing various parameters appears. The Instrument’s Computer Name is shown in the 
list alongside the title “Computer Name”. 

From the Windows Desktop (with a mouse attached to the Instrument):

1. Click Start, Control Panel. 

2. If the Control Panel window appears in Category View, click Performance and Maintenance, 
then System, to display the System Properties dialog. If the Control Panel appears in Classic 
View, double-click System to display the System Properties dialog. 

3. Click on the Computer Name tab of the System Properties dialog. 

4. To close the System Properties dialog, click Cancel.

From the Windows Desktop (without a mouse attached to the Instrument):

1. Press Ctrl+Esc to display the Windows Start menu, then use the Up Arrow or Down Arrow keys to 
select the Control Panel item. Press Enter to open the Control Panel dialog.

2. If the Control Panel window appears in Category View, press Tab to select Performance and 
Maintenance, then press Tab to select System. The System Properties dialog is displayed. If the 
Control Panel appears in Classic View, press Tab to select System, then press Enter, to display 
the System Properties dialog. 

3. Press Ctrl+Tab until the Computer Name tab is selected. The Computer Name is displayed under 
“Full computer name.”

4. To close the System Properties dialog, press Tab to select the Cancel button, then press Enter.

5. To close the Control Panel dialog, press Alt+Select to open the drop-down File menu, then press 
the Down Arrow until the Close menu item is selected. Press Enter to close the Control Panel 
dialog.
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Embedded Web Server: Using the N9020A Remotely
The instrument can be controlled using either the Embedded Web Server or Windows Remote 
Desktop. The Embedded Web Server is a good solution when you do not want to log into the 
instrument's user account. This allows you to view display or control the instrument, without 
logging the current user off. Windows Remote Desktop must be used when the remote computer 
keyboard is needed as an input device (such as for editing filenames, or setting the title.) Also, 
Windows Remote Desktop generally has a faster response time.

Accessing the Instrument via the Internet: Overview

It is possible to access and control the Instrument via the Internet and World Wide Web, or a local 
internet, using the built-in Embedded Server functionality. This chapter provides details of how to 
use this functionality.

The Instrument may also be accessed and controlled using the Windows Remote Desktop 
functionality (see the section “Remote Desktop: Using the N9020A Remotely” on page  54, for 
details).

The Instrument Embedded Server capabilities are fully compliant with the LXI (LAN eXtensions 
for Instrumentation) standard. 

How To Access the Instrument from the Internet

NOTE In order to gain access to the Instrument from the LAN, you need to know its 
hostname (or IP Address). For details of how to locate this information via the 
Instrument Display, see “How To Locate the Computer Name of the Instrument”.

To access the Instrument from the Internet, do the following:
(This is only fully supported when using Internet Explorer.)

1. From a web browser (e.g., Internet Explorer), enter a URL corresponding to the Instrument 
hostname or IP Address. An example is given below using Internet Explorer. In this example the 
host name is “a-n9020a-10010”.

2. Upon successful connection to the Instrument web server, the welcome page is displayed, which 
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provides basic information about the Instrument’s internet settings.
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3. Clicking on the Advanced Information drop-down on the welcome page displays further settings 
and configuration information.

4. At the left hand side of the welcome page are a set of tabs that provide access to configuration 
information for the Instrument, plus the ability to control it via the web interface. For more 
information about the functionality available under each tab, see the following sections:

• “View & Modify Configuration Tab” on page  70

• “Web Control SA Tab” on page  72

• “Get Data Tab” on page  75

• “Get Image Tab” on page  76

• “SCPI Telnet Tab” on page  77

• “Help Tab” on page  79
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View & Modify Configuration Tab

Clicking on this tab displays the following web page, which shows the Instrument’s 
currently-assigned IP address, plus other TCP/IP parameters:

To modify the current configuration, do the following:

1. Click on either of the Modify Configuration buttons on the Current Configuration web page.
Chapter 470



Using Microsoft Windows XP
Embedded Web Server: Using the N9020A Remotely
2. A password entry dialog appears, as shown:

3. By default, this password is set at the factory as “agilent”. Note, however, that the user may 
subsequently change the password. (Press System, Config I/O, Reset Web Password on the 
instrument front panel to change the password.)
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4. When the correct password has been entered, the Modify Configuration web page appears, as 
shown:

5. Enter new settings as required, then click Apply to cause the new settings to take effect. The 
button Undo Changes may be used to revert all settings to their previous values, provided this 
button is clicked before clicking Apply. The Start Identify and Stop Identify buttons are used 
respectively to enable and disable the LXI status indicator in the Instrument.

NOTE Tool tips are available for each of the configuration buttons on this page.

Web Control SA Tab

Selecting this tab lets you view, control and interact with the the Instrument via the web server.

1. Click on the Web Control SA tab.
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2. A password entry dialog appears, as shown:

3. By default, this password is set at the factory as “agilent”. Note, however, that the user may 
subsequently change the password. (Press System, Config I/O, Reset Web Password on the 
instrument front panel, to change the password.)
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4. When the correct password has been entered, the instrument control web page is displayed.

NOTE In order to view the instrument display using the web server, the instrument 
application must be running.

The web page shows the instrument application screen. Click the Display Front Panel Keys 
link to bring up a virtual keyboard that can be used to control the instrument. You can use the 
on-screen buttons to perform operations as though you were sitting in front of the instrument 
itself, and using the physical front panel.
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Get Data Tab

Selecting the Get Data tab allows you to capture results from the Instrument’s currently active 
measurement. Depending on the current measurement type, captured results consist of either 
Trace Data or Measurement Results.

NOTE In order to capture data via the web server, the Instrument Application must be 
running.

The captured data is formatted as a Comma Separated Value (CSV) file, which may be saved on the 
client computer’s hard disk, or opened with a spreadsheet application such as Microsoft Excel, or 
imported into a database application such as Microsoft Access.
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A typical Get Data web page display is shown below:

If the measurement currently running does not support the selected result type, the web page 
indicates this:

Get Image Tab

Selecting the Get Image tab captures a screen from the Instrument display.
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NOTE In order to capture a screen image via the web server, the Instrument Application 
must be running.

The image is captured as a Portable Network Graphics (PNG) file, to the default file name 
Screen.png. The image file can be saved to the client computer hard disk, or copied to the Windows 
clipboard.

A typical screen capture image appears as follows:

SCPI Telnet Tab

Selecting the SCPI Telnet tab opens a Telnet session between the Instrument and the client 
computer. The Instrument TCP/IP port used for SCPI access is 5023.

NOTE In order to run a SCPI Telnet session, the Instrument Application must be running.
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1. A password entry dialog appears, as shown:

2. By default, this password is set at the factory as “agilent”. Note, however, that the user may 
subsequently change the password. (Press System, Config I/O, Reset Web Password on the 
instrument front panel, to change the password.)

3. When the correct password has been entered, the connection window appears, as shown:
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4. Click on the SCPI Telnet Session link, and the telnet command line interface appears:

SCPI commands and queries may be entered via the command line interface. To exit the Telnet 
session, press Ctrl+] on the client computer keyboard.

Help Tab

Selecting the Help tab displays basic help information about each of the other tabs, plus 
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performance tips, as shown:
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Capturing/Printing Displays and Windows

NOTE This capture/print functionality is a Microsoft Windows XP capability. The following 
discussion provides some guidelines for using this capability with the instrument. You 
will have to refer to the Windows XP help documentation for more information.

You need an external keyboard and mouse to use this feature.

Save the Desktop: 

1. Capture the entire desktop by pressing the external keyboard Print Screen key. This saves the 
desktop on the Windows clipboard.

2. Open a graphics software program like Microsoft Paint.

3. Paste the clipboard contents into the program. (Ctrl + v)

4. Save the the image in a file.

Save the Current Active Window: 

1. Click on the window you want to capture (activate it).

2. Capture the window by pressing the keys on the external keyboard Alt + Print Screen key. This 
saves the active window on the Windows clipboard.

3. Open a graphics software program like Microsoft Paint.

4. Paste the clipboard contents into the program. (Ctrl + v)

5. Save the the image in a file.
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Windows Shortcuts and Miscellaneous Tasks
This section provides a list of windows shortcuts (key combinations) that are useful when you 
operate the instrument without an attached mouse and keyboard. (See also “Navigating Windows 
Without a Mouse”.) Although these shortcuts are available in any Windows XP system, they are not 
commonly used when a mouse and keyboard are attached.

This section also includes details of certain windows tasks that may be required from time to time 
when using or configuring the Instrument.

Windows Shortcuts (Key Combinations)

You can use the following combinations of front panel keys to perform basic windows tasks when 
using the instrument without an attached mouse and keyboard.

Table 4-2. Windows Shortcut Key Combinations

To do the following: Press:

Display the Windows Start Menu Ctrl+Esc

Cycle through all open applications Alt+Tab

Select the first menu of a menu bar Alt

Move through menu headings Left Arrow, Right Arrow

Open (drop down) a menu Down Arrow

Move through items in an expanded menu Up Arrow, Down Arrow

Close the current menu selection Esc

Cancel the current menu bar selection Alt

Open an application’s control menu (usually the left-most 
menu on the menu bar, starting with File)

Alt+Select

In a dialog: move between tabs Ctrl+Tab

In a dialog: move forward through dialog box items Tab

In a dialog: move backward through dialog box items Shift+Tab

In a dialog: open a list box Alt+Down Arrow

In a dialog list box or check box: select or deselect items Select

In a dialog list box or check box: select or deselect one item at 
a time

Shift+Up Arrow, Shift+Down Arrow

In My Computer, expand a selected folder Enter

In My Computer, open a folder one level up from the current 
folder

Bk Sp
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Example: Navigating an Application Menu without a Mouse or Keyboard

This example uses Microsoft Excel, but you can use a similar sequence of operations to select and 
execute any menu item of any application.

To select and execute the item Sheet > Rename option from the Format menu in the menu bar 
shown below

perform the following operations:

1. With the focus in the appropriate window, press Alt to select the File menu in the menu bar.

2. Use the Right Arrow and Left Arrow keys to move horizontally to the Format menu.

3. Press Down Arrow to expand the Format menu.

4. Use the Down Arrow and Up Arrow keys to move vertically to the Sheet menu item.

5. Press Right Arrow to expand the Sheet sub-menu.

6. The Rename sub-menu item appears already selected. (If another item in the same sub-menu is 
required, use the Down Arrow and Up Arrow keys to move vertically to that item.)

7. Press Enter to execute the selected action.

Windows Taskbar: Auto-hide

The Windows taskbar should always be in the auto-hide mode when using the instrument 
application. If the taskbar is not set to auto-hide, the lower part of the instrument display is 
obscured by the taskbar. 

If a mouse is attached to the instrument, and you move the mouse cursor to the bottom of the 
display (either deliberately or accidentally), the taskbar automatically appears. Provided that the 
taskbar is in auto-hide mode, you can make it disappear again by moving the mouse cursor away 
from the bottom of the screen.

If at any time the Windows taskbar is inadvertently set to the non-auto-hide mode, you can restore 
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the auto-hide behavior by doing the following:

1. Click Start > Control Panel. If not using a mouse, press Ctrl+Esc.

2. If the Control Panel window appears in Classic View, click Taskbar and Start Menu. If the 
Control Panel window appears in Category View, click Appearance and Themes > Taskbar and 
Start Menu. If not using a mouse, use the shortcut key combinations specified in the Section 
“Windows Shortcuts (Key Combinations)” on page  82 to make these selections.

3. The Taskbar and Start Menu Properties dialog appears. Select the Taskbar tab.

4. Check the Auto-hide the taskbar check box. If not using a mouse, press Tab repeatedly until 
the auto-hide option is selected, then press Select to toggle the check box state.

5. Click or select OK to apply the change and close the dialog.

The Windows Startup Folder

All Windows XP systems include a special folder, called the Startup folder. If a program, or a 
shortcut to a program, is placed in the Startup folder (either by Windows itself, or by a third-party 
application, or by any user), that program automatically runs every time Windows is restarted. 

When your instrument is first configured by Agilent, shortcuts to the appropriate application 
software and supporting programs are placed in the Startup folder. The exact contents of the 
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Startup folder depends on the options you purchased with your instrument. 

IMPORTANT You should never delete items that appear in the Startup folder, or move any item from 
the Startup folder to another folder. Deleting or moving any item in the Startup folder 
may cause applications not to start automatically when Windows is restarted, or may 
cause certain options to be unavailable when using the instrument.

If you wish to view the contents of the Startup folder, do one of the following:

• Either click Start, All Programs, then select Startup, or,

• Click Start, My Computer, then navigate to the folder C:\Documents and Settings\All 
Users\Start Menu\Programs\Startup. (Note that additional startup items may also appear in 
the corresponding startup folder for the user that is currently logged on. For example, the 
startup folder for the administrator user is C:\Documents and 
Settings\administrator\Start Menu\Programs\Startup.)
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5 Troubleshooting
• “Check the Basics” on page 88

• “Problems with Microsoft Windows XP” on page 90

• “Returning an Analyzer for Service” on page 91

WARNING No operator serviceable parts inside. Refer servicing to qualified personnel. 
To prevent electrical shock do not remove covers.
Chapter 5 87



Troubleshooting
Check the Basics
Check the Basics

❏ Is there power at the receptacle? 

❏ Is the analyzer turned on? Check to see if the green LED beside the power switch is on. Also, 
listen for internal fan noise to determine if the analyzer cooling fans are running. 

❏ If other equipment, cables, and connectors are being used with your signal analyzer, make sure 
they are connected properly and operating correctly. 

❏ Is the Measurement Application running? If not, there is a software launch shortcut/icon on the 
desktop.

❏ Does the instrument application have the focus? (That is, is the blue window banner 
highlighted?) If not, move focus to the application with Alt-Tab.

❏ Review the measurement procedures being performed when the problem first appeared. Are all 
of the settings correct? 

❏ If the analyzer is not functioning as expected, return the analyzer to a known state by pressing 
Mode Preset.

NOTE Some analyzer settings are not affected by a Preset. If you wish to reset the analyzer 
settings, press System, Power On, Restore Power On Defaults.

❏ Is the measurement being performed, and the results that are expected, within the specifications 
and capabilities of the analyzer? Refer to the specifications guide for your analyzer. Technical 
manual pdf files are available in the instrument (C:\Program 
Files\Agilent\SignalAnalysis\Infrastructure\Help\files), on the documentations cd provided 
with the instrument, and on the Agilent website (http://www.agilent.com/find/mxa_manuals).

❏ If the analyzer is not communicating via the LAN connection, check for the presence of blinking 
yellow LEDs on the rear panel LAN connector. If the receive LED is not blinking, check the LAN 
cable and LAN integrity.

❏ To meet specifications, the analyzer must be aligned. Either the Auto Align (On) feature must be 
selected (press System, Alignments, Auto Align, Normal), or the analyzer must be manually 
aligned. 

❏ Perform an Alignment. Press System, Alignments, Align Now, All. 

❏ If the previously performed alignments did not resolve the problem, press System, Alignments, 
Restore Align Defaults. Then press System, Alignments, Align Now, All.

❏ Is the analyzer displaying an error message? If so, refer to the Instrument Messages Guide.

❏ Check if the external frequency reference is selected but not available. Verify that it is selected 
by pressing Input/Output, Freq Ref In. If External is selected, changing the setting to Sense allows 
the analyzer to sense the presence of an external reference and use it only if it is available. The 
frequency of the reference should be set correctly.

❏ If you are using a Windows program, other than the instrument application, you may notice it 
Chapter 588

http://www.agilent.com/find/mxa_manuals


Troubleshooting
Check the Basics
running slow. Place the instrument application in single sweep/measurement.

TIP You can get automatic electronic notification of new firmware releases and other 
product updates/information by subscribing to the Agilent Technologies Test & 
Measurement E-Mail Notification Service for the MXA at 
http://agilent.com/find/notifyme
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Problems with Microsoft Windows XP
The Microsoft Windows XP operating system settings have been optimized for the best 
performance. Modification of these settings may degrade instrument performance and 
measurement speed. Those that can be safely modified are described in Chapter 3 , “Instrument 
Configuration.”

The N9020A is an Open Windows environment, so you can install software on the instrument. 
However, installation of non-approved software may affect instrument performance. Agilent does 
not warrant the performance with non-approved software installed.
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Returning an Analyzer for Service

Calling Agilent Technologies 

Agilent Technologies has offices around the world to provide you with complete support for your 
analyzer. To obtain servicing information or to order replacement parts, contact the nearest Agilent 
Technologies office listed below. In any correspondence or telephone conversations, refer to your 
analyzer by its product number, full serial number, and software revision. 

Press System, Show, System, and the product number, serial number, and software revision 
information will be displayed on your analyzer screen. A serial number label is also attached to the 
rear panel of the analyzer.

Locations for Agilent Technologies

Read the Warranty 

The warranty for your analyzer is in the front of your Specifications Guide. Please read it and 
become familiar with its terms. 

If your analyzer is covered by a separate maintenance agreement, please be familiar with its terms. 

Service Options 

Agilent Technologies offers several optional maintenance plans to service your analyzer after the 
warranty has expired. Call your Agilent Technologies office for full details. 

If you want to service the analyzer yourself after the warranty expires, you can purchase the service 
documentation that provides all necessary test and maintenance information. 

You can order the service documentation, Option 0BW (assembly level troubleshooting information) 
through your Agilent Technologies office.

Service Tag

When you are returning an analyzer to Agilent Technologies for service, fill out and attach one of 
the blue service tags provided at the end of this chapter. Please be as specific as possible about the 

Online assistance:  http://www.agilent.com/find/assist

United States
(tel) 1 800 829 4444
(fax) 1 800 829 4433

Latin America
(tel) (305) 269 7500
(fax) (305) 269 7599

New Zealand
(tel) 0 800 738 378
(fax) 64 4 495 8950

Canada
(tel) 1 877 894 4414
(fax) (905) 282-6495

Japan
(tel) (81) 426 56 7832
(fax) (81) 426 56 7840

Asia Pacific
(tel) (852) 3197 7777
(fax) (852) 2506 9284

Europe
(tel) (31 20) 547 2323
(fax) (31 20) 547 2390

Australia
(tel) 1 800 629 485
(fax) (61 3) 9210 5947
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problem. If you have recorded any error messages that appeared on the display, have completed a 
functional test, or have any other specific data on the performance of your analyzer, please include a 
copy of this information. An example of the tag is shown below.

Packaging the Instrument

Use original packaging or comparable. It is best to pack the unit in the original factory packaging 
materials if they are available.

CAUTION Analyzer damage can result from using packaging materials other than those 
specified. Never use styrene pellets in any shape as packaging materials. They do not 
adequately cushion the equipment or prevent it from shifting in the carton. They cause 
equipment damage by generating static electricity and by lodging in the analyzer 
louvers, blocking airflow. 

You can repackage the analyzer with commercially available materials, as follows:
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1. Attach a completed service tag to the analyzer.

2. Wrap the analyzer in antistatic plastic to reduce the possibility of damage caused by electrostatic 
discharge. 

3. Use a strong shipping container. The carton must be both large enough and strong enough to 
accommodate the analyzer. A double-walled, corrugated cardboard carton with 159 kg (350 lb) 
bursting strength is adequate. Allow at least 3 to 4 inches on all sides of the analyzer for packing 
material. 

4. Surround the equipment with three to four inches of packing material and prevent the 
equipment from moving in the carton. If packing foam is not available, the best alternative is 
plastic bubble-pak. This material looks like a plastic sheet filled with 1-1/4 inch air bubbles. Use 
the pink-colored bubble which reduces static electricity. Wrapping the equipment several times 
in this material should both protect the equipment and prevent it from moving in the carton. 

5. Seal the shipping container securely with strong nylon adhesive tape. 

6. Mark the shipping container “FRAGILE, HANDLE WITH CARE” to assure careful handling. 

7. Retain copies of all shipping papers. 
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